
What is a Computer?

A computer is an electronic device that manipulates

information, or data. It has the ability to store, retrieve, and

process data. You may already know that you can use a

computer to type documents, send email, play games, and

browse the Web. You can also use it to edit or create

spreadsheets, presentations, and even videos.



Hardware and Software

All computers have two things in common:

hardware and software.



Hardware is any part of your computer

that has a physical structure, such as

the keyboard or mouse. It also includes

all of the computer's internal parts.





Software is any set of instructions that

tells the hardware what to do and how

to do it. Examples of software include

web browsers, games, and word

processors.





Everything you do on your computer will

rely on both hardware and software. For

example, right now you may be viewing

this lesson in a web browser (software)

and using your mouse (hardware) to

click from page to page.





Desktop computers



Many people use desktop computers at

work, home, and school. Desktop

computers are designed to be placed

on a desk, and they're typically made

up of a few different parts, including the

computer case, monitor, keyboard, and

mouse.



Laptop computers



The second type of computer you may

be familiar with is a laptop computer,

commonly called a laptop. Laptops are

battery-powered computers that are

more portable than desktops, allowing

you to use them almost anywhere.



Tablet computers



Tablet computers—or tablets—are

handheld computers that are even more

portable than laptops. Instead of a

keyboard and mouse, tablets use a

touch-sensitive screen for typing and

navigation. The iPad is an example of a

tablet.



Servers

A server is a computer that serves up information

to other computers on a network. For example,

whenever you use the Internet, you're looking at

something that's stored on a server. Many

businesses also use local file servers to store and

share files internally.



Other types of computers

 Smartphones: Many cell phones 

can do a lot of things computers can 

do, including browsing the Internet 

and playing games.



 Game consoles: A game console is 

a specialized type of computer that 

is used for playing video games on 

your TV.



 Wearables: Wearable technology is a 

general term for a group of devices—

including fitness trackers and 

smartwatches—that are designed to be 

worn throughout the day. 



 TVs: Many TVs now include 

applications that let you access 

various types of online content. For 

example, you can stream video from 

the Internet directly onto your TV.



Google Workspace for Education 

In the COVID-19 era, teachers and educators around the globe are trying their best to manage the 

teaching difficulties associated with being online. The transition to online learning, screen fatigue, a lack 

of physical interaction, inadequate resources, and unfamiliarity with teaching in a new environment 

have all contributed to the challenges associated with information & communication technologies (ICT). 

However, the prompt innovation of various applications, systems, and online teaching methodologies 

improved the academic experience. 

One component of a learning tool that was integrated and developed rapidly was the usage of learning 

management systems (LMS). An efficient LMS provides features that support 

online or offline learning activities, such as supplementary textbook activities, 

assignment submissions, on-demand discussions and forums, and interactive 

elements. While many LMS systems are being utilized in all facets of academic 

education, one of the more popular applications used in many institutions is 

Google Workspace for Education, formerly Google G-Suite for Education (De 

Vynck and Bergen, 2020). 

The original idea was to connect schools and institutions to these apps (ibid.). 

That same year, Google introduced the educational productivity apps Google 

Docs, Sheets, Forms, and Slides. This became the Google for X Edition series, 

divided into individual, business, education, and government subcategories. 

As the internet continued to grow rapidly in popularity , Google introduced its 

Google Drive service, which allowed users to store data and files in the cloud. This was to compete with 

several popular cloud-based storage systems, including Dropbox, OneDrive, Apple iCloud, and Box.com . 

Shiohara points out that Google Drive arguably migrated a number of new and existing users onto the 

Google ecosystem not only for its cloud storage but also for the integration to other Google Apps, 

something that the other competing storage systems did not have at the time. 

Another major Google educational app developed after Google Drive was Googleʼs own LMS software, 

Google Classroom. Google Classroom is seamlessly integrated into the Google suite, allowing institutions 

to assign and collect submissions from any Google app. 

 

 

 

 



GOOGLE APPS  

GOOGLE CLASSROOM 

Arguably one of the most significant draws to joining the Google 

platform, the Google Classroom LMS enables teachers to create an online classroom where they can 

manage and integrate virtually all files created from any Google app. Instructors can distribute materials 

on the subject being taught, post supplementary resources, assign tasks and assignments to students, 

and upload grades in real time so students can keep track of their progress. 

 



Microsoft Word 

Microsoft Word is a powerful word processing program that gives users the tools 

to create a variety of professional documents. Word automatically checks your 

spelling and grammar and corrects common mistakes. It even lets you insert 

charts, tables, and pictures into your documents. Microsoft Word is the most 

widely used and, according to most reviews, the most powerful and user-friendly 

word processor available. 

Microsoft Word   هو برنامج معالجة نصوص قوي يمنح المستخدمين الأدوات اللازمة لإنشاء مجموعة

تلقائياً بفحص التهجئة والقواعد النحوية وتصحيح الأخطاء    Wordالمستندات الاحترافية. يقوم متنوعة من 

هو برنامج   Microsoft Wordالشائعة. كما يتيح لك إدراج المخططات والجداول والصور في مستنداتك. 

 جعات. معالجة النصوص الأكثر استخدامًا والأكثر قوة وسهولة في الاستخدام وفقًا لمعظم المرا

 

Starting Word  
In order to use a program, you must start—or launch—it first. 

1.Click the Startbutton. 

The Start menu appears.  

2.Click All Programs. 

The left pane of the Start menu 

displays the programs and menus 

installed on your computer. 

3.Click Microsoft Office. 

4.Select Microsoft Word  

 

 

Or you can launch Word from the 

shortcut icon on your desktop 

 

 

 

 

 

 

 

 



 

Microsoft Word interface 



Giving Commands in Word 
Word  provides easy access to commands through the Ribbon, File tab, and Quick 

Access Toolbar. 

 
Ribbon 
The Ribbon keeps commands visible while you work insteadof hiding them under 

menus or toolbars, and it is the primary way to give commands in Word .The 

Ribbon is made up of three basic components: tabs, groups, and buttons. 

 

Tabs: Commands are organized into tabson the Ribbon. Each tab contains a 

different set of commands. There are three different types of tabs: 

• Command tabs: These tabs 

appear by default whenever you 

open the Word 2010program. In 

Word 2010, the Home, Insert, 

Page Layout, References, 

Mailings, Review, and View tabs 

appear by default. 

• Contextual tabs: Contextual 

tabs appear wheneveryou 

perform a specific task,and they 

offer commands relative to only 

that task. For example, whenever 

you select a picture, the Format 

tab appears in the Ribbon under 

Picture Tools. 

• Program tabs: If you switch to 

a different authoring mode or 

view, such as Outline view, 

program tabs appear next to the 

default command tabs that 

appear on the Ribbon. 

 

Groups: The commands found on each tab are organized into groupsof related 

commands. For example, the Font group contains commands used for formatting 

fonts. Click the Dialog Box Launcher () in the bottom-right corner of a group to 

display even more commands.  



 

Buttons: One way to issue a command is by clicking its buttonon the Ribbon. 

Buttons are the smallest element of the Ribbon and change color when clicked. 

 

File tab 
The File tab appears in the 

upper-left corner of the 

program window. When 

clicked, it opens Backstage 

view, which is where you find 

commands for basic file 

management, including New, 

which creates a new file; 

Open, which opens an 

existing file; Save, which 

saves the currently opened 

file; and Close, which closes 

the currently opened file. 

This is also where you find 

commands for controlling 

program options and sharing. 

 

 

Save: Used to save changes made to the document 

Save As: To save a copy of the document under another name or in another 

location or save it in another format such as PDF. 

Open: Used to open stored documents 

Close: The purpose of ending the program is to close it and exit it (with or without 

saving the changes) 

Information: Includes information or properties about the current document 

Recent: The ability to view or open recently opened documents 



New: Used to open a new document 

Print: To print the pages of the document on paper 

Options: Includes a group of options that can control the properties of the 

document such as controlling the program interface, the default font type, 

controlling the spelling properties, controlling the languages used in printing and 

setting the dictionary, etc. 

 

Quick Access Toolbar 
The Quick Access Toolbarappears to the right 

of the File taband provides easy access to the 

commands you use most frequently. By 

default, the Save, Undo, and Redo buttons 

appear on the toolbar; however, you can 

customize this toolbar to meet your needs by 

adding or removing buttons. 

 

 
 
 



Contextual menus 
A contextual menudisplays a list of commands 

related to a specific object or area. To open a 

contextual menu: 

1.Right-click an object or area of the document or 

program screen.  

A contextual menu appears, displaying commands 

that are relevant to the object or area that you right-

clicked. 

2.Select an option from the contextual menu, or 

click anywhere outside the contextual menu to 

close it without selecting anything. 
 
 
Mini Toolbar 
The Mini Toolbarappears whenever you select text 

and contains common text formatting commands. 

To view the Mini Toolbar: 

1.Select a block of text. 

The Mini Toolbar appears nearthe text you 

selected. 

 

2.Click a button on the Mini Toolbar. 

The command is given in Word. 

 



Enteringand Deleting Text 
Inserting and deleting text is one of the most important tasks you need to learn how 

to do in Word. 

 
Enter text 
Use the Click and Type feature to enter text in a blank area of the document.  

 

Double-click a blank area of the 

document where you want 

toposition your text and start 

typing. 

 

Double-click near the left side 

of the page to align text to the 

left of the page. 

 

Double-click near the center of 

the page to center text over the 

page. 

 

Double-click near the right side 

of the page to align textto the 

right of the page. 

 

Tip:Press the <Enter>key to start a new paragraph or insert an empty line. 

 
Delete text 

• To delete a single character:Place the insertion point next to the text that 

you want to delete. Press the <Delete>key to delete text after, or to the right 

of, the insertion point. Press the <Backspace>key to delete text before, or to 

the left of, the insertion point. 

• To delete a block of text:Select the text you want to delete and press 

<Delete>or <Backspace>. 

 

 

 

 



Inserting Symbols and Special Characters 
Your keyboard doesn’t contain all the characters you might want to include in your 

documents. Word lets you insert these special symbolsand characters, and even 

equations, separately. 

 
Insert symbols 
You can enter many more characters and symbols in a document than can be found 

on the keyboard. For example, youcan insert the copyright symbol (©), accented 

and foreign characters (ç), silly 

characters (☺), and many more. 

 
1.Place the insertion point where 

you want to insert the symbol or 

character. 

 
2.Click the Insert tab on the 

Ribbon and click the 

Symbolbutton in the Symbols 

group. 

If you see the symbol you want to 

use under the Symbol button, 

select it. Otherwise, open the 

Symbol dialog box. 

 
3.Select More Symbols. 

The Symbol dialog box appears. You can browse the different symbols by 

changing the Font and Subset of symbols. Special characters such as ellipses are 

available under the Special Characters tab.  

 
4.Select the symbol you want to use and click Insert. 

The symbol is inserted into the document. 

 
 
 
 
 
 
 
 
 



Insert an equation 
You may insert a common equation already 

put together in Word, such as the Area of a 

Circle , or build a new equation using the 

Equation Design Tools. 

 
1.Click the Inserttab on the Ribbon and 

click the Equationbutton in the Symbols 

group. 

A placeholder for the equation appears in 

the document, and the Equation Tools 

appear on the Ribbon. The Design tab is 

displayed. 

 
2.Type the equation in the placeholder. 

You may use the keyboard and the Equation Design Tools on the Ribbon to write 

the equation. 

 

Copying and Moving Text 
You can move or copy text in a Word document by copying or cutting, and then 

pasting the text in a new place.  

 
Copy text 
When you copytext, the selected text remains in its original location and is added 

to the Clipboard. 

 
1.Select the text you want to copy. 

 
2.Click the Hometab on the Ribbon and click the 

Copybutton in the Clipboard group. 

The text is added to the Clipboard, and it remains in the 

document. 

 
3.Place the insertion point where you want to paste the 

copied content. 

The text will be inserted to the right of the insertion point. 

 



4.Click the Hometab on the Ribbon and click the Pastebutton in the Clipboard 

group. 

The copied text is pasted in the new location. 

 

Move text 
Moving text typically involves a process of cutting and pasting. When you cuttext, 

it is removed from its original location and placed in a temporary storage area 

called the Clipboard. 

 
1.Select the text you want to move. 

 
2.Click the Hometab on the Ribbon and click the Cutbutton in the Clipboard 

group. 

The text is removed from the document and added to the Clipboard. 

 
3.Place the insertion point where you want to paste the copied content. 

The text will be inserted to the right of the insertion point. 

 
4.Click the Hometab on the Ribbon and click the Pastebutton in the Clipboard 

group. 

The copied text is pasted in the new location. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Controlling How Text is Copied or Moved 
You can control how text looks or behaves when it is pasted. For example, you can 

keep the text’s formatting, or have it take on the formatting properties of the 

destination. 

 
Use paste options 
You can control how content is pasted in 

your spreadsheets using the paste options 

in Word. 

 
1.Copy or cut an item as you normally 

would. 

 
2.Click where you want to paste the item. 

 
3.Right-click the mouse and select 

Pastefrom the contextual menu. 

The content is pasted into the 

document.The Paste Options button 

appears in the lower-right corner ofthe 

pasted content. 

 
4.Click the Paste Optionsbutton. 

A list of different ways you can paste the content appears.  

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 



Changing Font Type 
One way to emphasize text in a documentis by changing its font type. A fonttype 

is a set of characters with the same design and shape.  

 
1.Select the text you want to format. 

 
2.Click the Hometab on the 

Ribbon and click the Fontlist 

arrow in the Font group. 

A list of the fonts that are 

available on your computer 

appears. 

 
3.Select a font from the list. 

The selected text is changed, 

and any new text that you enter 

will appear in the new font 

type. 

 

Other Ways to Change Font 

Type:When text is selected, 

click the Font list arrow on the 

Mini Toolbar. Or, click the 

Dialog Box Launcherin the 

Font group. 

 

 
 
 
Changing Font Size 
Making text largeris another way to emphasize 

text. 

 
1.Select the text you wish to format. 

 
2.Click the Hometab on the Ribbon and click 

the Font Sizelist arrow in the Font group. 

 

 



Changing Font Color and Highlighting Text 
Changing fontcoloris yet another way to 

emphasize text in a document. 

Change font color 
Changing font colormakes text stand out against 

the white background of the document. 

1.Select the text you wish to format. 

2.Click the Hometab on the Ribbon and click the 

Font Colorbutton list arrow in the Font group. 

 

 

 

Changing Font Styles and Effects 
In addition to changing font type, size, and color, you can also emphasize the text 

in a document by changing the font style and adding font effects. The most 

common and popular styles arebold, italic, and 

underline, but other effects can be applied, such 

as shadowand strikethrough. 

 
Change font style 
1.Select the text you wish to format. 

 

2.Click the Hometab on the Ribbon and click 

the appropriate button in the Font group. 

 

Creating Lists 
Lists are a great way to present paragraphs of related information. 

 
Create bulleted and numbered lists 
Usebulleted lists when the order of items in a 

list doesn’t matter, such as listing items you 

need to buy. When the order of items in a list 

does matter, such as to present step-by-step 

instructions, try using a numbered list.  

 



1.Select the lines you want to use for the list. 

Each line that you want to be bulleted or numbered 

must appear as its own paragraph. 

 

2.Click the Home tab on the Ribbon and click the 

Bulletsor Numberingbutton in the Paragraph 

group. 

 

 

Changing Paragraph Alignment 
This lesson moves on to paragraph formatting 

and how to align paragraphs to the left, right, 

center, or justified on a page. 

 
1.Place the insertion point in the paragraph you 

want to change. Or, select the paragraphs you 

want to change. 

 

2.Click the Hometab on the Ribbon and click the Align Left,Center,Align 

Right,orJustifybutton in the Paragraph group.  

 

Using Headers and Footers 
Documents with several pages often have information—such as the page number, 

the document’s title, or the date—located at the top or bottom of every page. Text 

that appears at the top of every page in a document is called a header, while text 

appearing at the bottom of each page is called a footer. 

 
Insert a built-in header or footer 
1.Click the Inserttab on the Ribbon and click the Headeror Footer button in the 

Header & Footer group. 



A list of built-in 

options appears. Each 

option looks different 

and contains different 

attributes. For 

example, some include 

placeholders for the 

title and date, while 

others include cross-

references to styles 

within the document. 

 

2.Select a built-in 

option to use as a 

document header or 

footer. 

The header or footer is added to the document. 

 
Create a header or footer 
You don’t have to use one of Word’s built-in 

headers or footers: you can create one of your 

own.  

 
1.Click the Inserttab on the Ribbon and click 

the Header or Footerbutton in the Header & 

Footer group. 

 
2.Select Edit Headeror Edit Footerfrom the 

list. 

The Header & Footer Design tab appears on the 

Ribbon. Use these commands to work with and 

insert elements into your headers and footers. 

 
3.Position the insertion point where you want to 

insert the text or element. 

The header and footer areas have the same 

formatting abilities as the main area of the 

document. You can use the commands in the 

Position group to help align and position the 

contents of the header or footer. 



 
4.Enter text and/or insert objects using the Insertgroup of the Design tab under 

Header & Footer Tools. 

When the header or footer looks the way you want it to, close Header and Footer 

view to resume work on the rest of the document. 

 

Apply a style 
Choose a style that is appropriate for the text, and then apply the style. 

 
1.Select the text to which 

you want to apply the style. 

 
2.Click the Hometab on 

theRibbon and click the style you want to use in the Styles Gallery in the Styles 

group. 

The style is applied to the document. To view all the styles in the quick style set at 

the same time, click the Morebutton to expand the group. 

 

Applying Document Themes 
Word 2010’s document themes provide a consistent and professional look for your 

documents. Each document theme consists of three design 

elements: 

 

Apply a document theme 
Applying a document themeaffects all elements of the 

document: colors, fonts, and effects. 

 
1.Click the Page Layouttab on the Ribbon and click the 

Themesbutton in the Themes group. 

A list of built-in document themes appears. The default theme 

is “Office,” which is highlighted in orange. 

 
2.Select the document theme you want to apply. 

The formatting associated with the document theme is applied 

to the document. 

 



InsertingWordArt 
WordArt is a fast and easy way to add dramatic and colorful effects to text in your 

documents.  

 
Insert WordArt 
Inserting Word Art is like 

inserting any other text box into 

your document, but with some 

additional formatting.  

 
1.Place the insertion point where 

you wish to insert the WordArt. 

Even though WordArt appears in 

the upper left hand corner of the 

document, it will use the style 

associated with wherever the 

insertion point is placed. 

 
2.Click the Inserttab on the 

Ribbon and click the 

WordArtbutton in the Text 

group. 

The WordArt gallery appears.  

 
3.Select a WordArt style from the gallery. 

A text box appears in the upper left corner of the document. 

 
4.Type the text you want to appear in the WordArt. 

The WordArt is inserted inthe document. 

 

 
 
 
 
 
 
 
 



Insert a table 
 

1.Click the Inserttab on the Ribbon and click the 

Tablebutton in the Tables group. 

A grid appears, representing rows and columns in 

the table. As you move the cursor inside the grid, 

the number of rows and columns that will appear 

in the table is updated at the top of the list. A 

preview of how the table will look in the 

document also appears as you drag your cursor 

across the grid. 

 

2.Select the number of columns and rows you 

want to create using the new table grid. 

The table is inserted with the number of columns and 

rows you selected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Using Table Styles 
You can easily spice up your tables by applying built-in table formatting styles. 

Apply a table style 
By default, a table is created with the Table Grid style, which includes a basic 

black border around each cell in the table. Word includes many built-in styles that 

include more interesting formatting. 

1.Select the table. 

2.Under Table Tools on the Ribbon, click the Designtab. 

Here you can see the Table Styles group. You can use the arrow buttons to scroll 

through the table styles in the gallery. 

3.Select the style you want to use in the Table Styles group. 

 

 

 

 

 

 

 



Starting PowerPoint2010 
 

Windows Vista and Windows 7 
1.Click the Startbutton. 

The Start menu appears.  

2.Click All Programs. 

The left pane of the Start menu displays the 

programs and menus installed on your 

computer. 

3.Click Microsoft Office. 

4.Select Microsoft PowerPoint2010. 

The PowerPoint2010 program screen 

appears. 

 

 

 

 

 

Creating a New Presentation 
Creating a new presentation is one of the most basic commands you need to know 

in PowerPoint. You can create a blank 

new presentation, such as the one that 

appears when you open PowerPoint, or 

you can create a new presentation 

based on a template. 

 
Create a new blank presentation 
1.Click the File tabon the Ribbon and 

select New. 

The New tab of Backstage view 

appears. By default, the Blank 

presentationoption is already selected. 

 

2.Make sure the Blank presentationoption is selected and click Create. 



Inserting Slides and Deleting Slides 
Slides are the building blocks of a presentation. This lesson will show you how to 

insert a new slide and how to delete a slide. 

 
Insert a new slide 
Inserting a new slide is quick and 

easy. 

Click the Hometab on the Ribbon 

and click the New Slide button in the 

Slides group. 

A new slide is added to the 

presentation. 

 
Delete a slide 
If you decide you don’t need a slide, delete it.  

1.On the Slides tab in the Outline pane, select the slide you want to delete. 

2.Press <Delete>. 

The slide is deleted. 

 

Inserting a Text Box 
Even though most slides have one or 

two placeholders for you to insert text, 

it’s a good idea to learn how to insert 

your own—especially if you plan on 

creating a blank presentation any time 

soon. 

Create a text box 
1.Click the Inserttab on the Ribbon and 

click the Text Box button in the Text 

group. 

The pointer changes to a , indicating 

you can draw a text box. 

2.Position the mouse pointer where you 

would like to insert the text box, and 

click and drag until the text box reaches 

the desired size. 

3.Release the mouse button.  

 



Using Document Themes 
A theme is a set of unified design 

elements that you can apply to a 

presentation to give it a consistent 

look and feel. Each document 

theme consists of three design 

elements: 

 

Theme Colors:A set of eight 

coordinated colors used in 

formatting text and objects in the 

presentation. 

Theme Fonts:A set of coordinated 

heading and body font types. 

Theme Effects:A set of 

coordinated formatting properties 

for shapes and objects in the 

document. 

 

 

Apply a document theme 
Applying a document theme affects 

all elements of a presentation: 

colors, fonts, and effects. 

 
1.Click the Designtab on the 

Ribbon and click the More button 

in the Themes group. 

The Themes gallery appears. The 

default theme is “Office,” which is 

highlighted in orange. 

 
2.Click the theme you want to 

apply. 

The formatting associated with the 

selected theme is applied to all of 

the slides in the presentation.  

 



Modify a document theme 
You are not bound to keep the colors, fonts, or effects that are assigned to a 

document theme. You can mix and match theme colors, theme fonts, and theme 

effects to meet your needs. 

1.Click the Design tab on the Ribbon and click the Variants 

2.Click the Theme Colors, Theme Fonts, or Theme Effects button in the Themes 

group and select the colors, fonts, or effects you want to use. 

PowerPoint applies your changes to the presentation. 

 

Inserting Pictures and Graphics Files 
 

1.Click the Inserttab on the Ribbon and 

click the Picturebutton in the Images 

group. 

The Insert Picture dialog box appears. 

2.Navigate to the location where the file 

you want to insert is stored. 

3.Click the name of the file you want to 

insert and click Insert. 

 

 

 

 

 

Applying a Transition Effect 
The ability to apply transitions to 

slides has improved in PowerPoint 

2010. Plus, some great new transition 

effects have been added.  

A transitionis an animation that 

occurs when PowerPoint advances 

from one slide to the next during a 

slide show. 



 

1.Select one slide to which you want to add a transition effect. 

2.Click the Transitionstab on the Ribbon and click the More button in the 

Transition to This Slide group. 

The Transitions gallery appears. To preview the transition, simply point to it.  

 
3.Select a transition effect from the gallery. 

 

Delivering a Presentation on a Computer 
 
Start a slide show 
 
1.Open the presentation you 

want to present. 

 

2.Click the Slide Showtab 

on the Ribbon and click the 

From Beginningbutton in 

the Start Slide Show group. 

 


